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Why We Changed a Good Thing

GraphicWorks 1.0 is one of the most flexible and powerful graphics tools ever produced for
the Macintosh. However, over the course of the past several months, we listened to users'
requests for additions and changes to make this great program even better. The result is
GraphicWorks 1.1. GraphicWorks 1.1 extends and enhances Version 1.0. Many new features
have been added, and the user interface has changed to allow you to work more quickly.

If you are already familiar with version 1.0, you will find things have changed enough that you
will need to relearn a few habits. You will also find that many of the oddities and glitches in
version 1.0 are gone. In general, you will probably find yourself back up to speed in a couple
of work sessions.

This addendum does not attempt to replace the program documentation. Therefore, it should
be used in conjunction with the rest of the book. The first thing to read is the section about the
user interface; after that, if you come to a point where you are in unfamiliar territory and the
regular manual does not apply, turn here for help. The addendum is broken down into a table
of contents; an introduction to the new user interface; a discussion of high-resolution drawing
and using TIFF files; a look at Quickdraw Primitives; a section on using color; a discussion of
laser printing strategies; a summary of other new features; a list of important but less obvious
changes from version 1.0; and finally, a brief overview of compatibility with other software.

Welcome to GraphicWorks 1.1, the most powerful paint, drawing, design, layout, and creativity
tool yet for the Macintosh.

The GraphicWorks Show

We're currently amassing a library of customer-created GraphicWorks output. We want
original work for our files as well as for use in future ads and promotional pieces. If you'd like
to share your work with us, and if we're free to reproduce it at no charge (although we'll
happily credit you with the creation), please send it, along with your name, address, and
telephone number, to :

The GraphicWorks Show

Mindscape, Inc.

P.O. Box 1167

Northbrook, IL 60065

As with any Mindscape product, we're most interested in your feedback and in your
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suggestions--suggestions both for improving our existing products and for developing new
ones. Please communicate with us via the Registration Card, by letter, or by phone. It's only
through close contact with our valued customers that we can continue to publish products the

caliber of GraphicWorks.

We're looking forward to hearing from you and receiving terrific output from you. Enjoy 1.1!
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The User Interface

The biggest change from version 1.0 is the streamlined user interface. GraphicWorks 1.1 uses
a new “context-sensitive” tool window to eliminate the need for balloon and panel shapes
windows.
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The Tool Window changes to reflect the currently selected item. For instance, if you select the
new panel tool, the tool window will change to look like this:

Nevy panel tool is selected

Available panel shapes appear here

Border thickness chosen here

Screen layout controls

As noted, you select the shape of the panel from the shapes which appear in the Tool
Window, and you select the border weight from the line weights area at the bottom.

This same basic mechanism is used when you select the new balloon tool as well. This
eliminates the need for separate shapes windows cluttering up the screen.




You are probably wondering about the lack of drawing tools. They will appear as soon as an
sasel is created or selected. As soon as you create or select an easel, the following will
appear:

Lasso Selection Marquee
Eraser Graphics Text
Fill Airbrush
Paintbrush Pencil
Line Rectangles
RoundRects Ovals
Regions Polygons
Free Rotate Skew
Perspective Distort

Line weights

As you can see, the full set of tools is present, and several new ones have been added. You
may have noted that the filled shapes have been removed from the tools window. This brings
us to another change of some importance, the pattern window.

Current fill pattern

I No fil Eunmllnaﬂarn set

Pattern set
salection

Current line pattern

The pattern window now controls whether or not a shape will be drawn filled. If you select




None and then draw a shape, it will consist solely of an outline. Any other pattern will produce
a filled shape. You can draw lines and shapes with patterned borders by clicking on LINE and
then on a pattern to use. Select from among the four pattern sets available by choosing 1,2,3
or 4. Note: When selecting a pattern, you now can drag through the pattern palette with the
mouse button pressed to switch patterns.

Setting Defaults

After selecting a creator tool (panel, easel, text balloon, or graphics primitive) but before
creating the object, you can set a default type. For example, you can set the line thickness for
a new panel, the balloon style for a new balloon, or the fill pattern for a new primitive. Before
you create the new thing, click on the line pattern, fill pattern, shape, line thickness, ink mode,
or color. The choice you make will be saved as the default type so that the next time you make
a new thing it will use the default you have set.

For example, select the new panel tool. Click on the triangle shape and the 4-pixel wide line
thickness. Now click on LINE in the pattern window and choose your favorite pattern for a
new border and click on it. Then draw out your panel in the window. You will get a triangular
panel with a thick border drawn in your favorite pattern. Now select the new panel tool and
make another panel. The default settings willbe used when creating this panel as well.

GraphicWorks 1.1 can automatically set your preferred defaults whenever you first start the
program. When the program starts, it looks for a file called Template. If it finds such a file, it
opens it (as Untitled) and reads in all the default characteristics for new objects.

Other than these changes, the program is used in the same manner as before. The basic
concepts of panel, easel and balloon have not changed.




Quickdraw Primitives and Pictures

Primitives
There is a totally new kind of object available in version 1.1: the primitive. Primitives are the

elements of what most people call "object-oriented” drawing. If you have used MacDraw™,
you are already familiar with primitives.

To create a primitive, you first click on the New Primitive Tool in the tools window.
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e

Your cursor will change as shown, and the shapes available to you will appear in the tool
window. To create a shape, simply select the one you wish to draw and then follow the
standard click-and-drag method you use to create panels, easels, and balloons. The polygon
and line tools behave exactly the same as their counterparts in easels, with the exception that
they can be re-shaped and re-filled at any time.

To change the size of a primitive, simply grab one of the small “handles” that appear at the
corners of the object. To reshape polygons, use the Reshape... command from the Layout
menu to activate the reshaping handles. Drag a handle to change the polygon's shape.
Handles can be added or deleted in the same manner as for balloons.

Primitives can have any fill color and any line color or weight and these qualities can be
changed at any time,

To set a primitive's patterns, simply click on the primitive to select it, click on the fill color you
want, select the LINE area in the Pattern Window and select the line pattern you want. The
primitive will be re-drawn with the new patterns.

The reason you might want to use primitives is that a quickdraw primitive is very memory
efficient and will be printed at the full resolution of whatever output device you are using,
whereas bitmaps are normally constrained to 72 d.p.i. (not always, though, as we'll see in a
little while) and are very memory hungry.
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Another advantage to using primitives in GraphicWorks 1.1 is that you can use the grays in the
second pattern set in the Pattern Window (click on the number 2) to select a Postscript gray
scale for your fills, These grays will print using the printer's standard grays instead of the on-
screen patterns.

Yet another reason to use primitives is the availability (through the Preferences command)
of true hairlines. You can set a custom line weight in the preferences window. If you click on
Screen units and type a number for line weight, that number will represent 72nds of an inch
(the Macintosh screen resolution). If, however, you choose LaserWriter units, the number
will be interpreted as 300ths of an inch. Thus, selecting LaserWriter units and typing a 2 will
produce a custom line thickness of 1/150 of an inch (2/300).

Preferences

Scaling amount (1-999) -‘I.

Font size (6-127)

Line thickness (1-72) |5 I

) Screen units (72 dpi)
@® LaserlWriter units (300 dpi)

[] Ignore color values.

] Turn off page buffer imaging.

Primitives are just like any other object in GraphicWorks. They are owned by panels and have
priority levels which can be adjusted with the Layout menu commands.

Primitives are affected by the Ink modes on screen and when printing as a bitmap or to an
ImageWriter | or Il, but not when printing to a Postscript device such as the LaserWriter. The
current implementation of Postscript does not include ink modes for graphics other than
bitmaps. Thus, this is a case where what you see on the screen may not be what you get on
the printer. Since the most common use for primitives seems to be for the construction of
borders and other highlighting devices, this will hopefully not be a major obstacle.
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Pictures
Pictures are also available in GraphicWorks 1.1. A picture (known as a PICT in Mac-speak)

is a standard Macintosh representation of an image which is treated as an object for scaling
and printing. PICTs can come from any of a number of sources. For instance, a MacDraw™ or
a Mac3D™ graphic transferred from the Clipboard or ScrapBook can be pasted in as a
Picture. What this means is that the image can be scaled and moved around, but not edited by
GraphicWorks 1.1. If you scale a picture to 50% of its original size, all the detail present in the
original image is retained when it is printed or resized. This is similar to the way MacWrite
treats graphics pasted in from another program. You can also paste a bitmapped image from
another paint program (or even from within GraphicWorks 1.1 itself) as a picture. Note: You
cannot set color for a PICT image that you bring into GraphicWorks 1.1; it must already be built
into the picture by the creating program.

Whenever you want to paste in an image as a picture, use the Paste as Picture command
in the Edit menu. The item will be identified in the lower left corner of the drawing window by
the word Picture. You can convert a picture to a bitmap at any time by using the Convert to

Easel command in the Feature menu.
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High Resolution Drawing and TIFF Files

High resolution Easels

One of the most important aspects of Desktop Publishing is illustration. GraphicWorks was
designed to approach DTP from the illustrator's point of view. One of our major goals with
version 1.1 has been to create a method for working at higher resolution than the screen
allows. The current Macintosh display, as attractive as it is, is limited to 72 dots per inch in
both the vertical and horizontal axes. This is also the limitation of standard bitmap paint
programs, including GraphicWorks 1.0.

There are two related solutions to this problem in GraphicWorks 1.1. The first invoives “high-
resolution” easels. Using the Bitmap Resolution command in the Windows menu, it is
possible to set the bit image resolution from 72 dots per inch (d.p.i.) on up. Thus, if you have a
300 d.p.i. LaserWriter, you can create a bitmapped drawing using all of GraphicWorks great
painting tools which will print at the full resolution of the printer.

As an example, assume you want to create a high-quality Mindscape logo using the high-
resolution capabilities of the program. There are two ways to go about it. The first (and less
precise) way would be to create a logo approximately four times the size you need, then
select Bitmap Resolution from the Window menu. When the window appears, click the
button for 288 dots per inch, and the button labeled Same number of bits in image. Now,
when you deselect the hi-resolution easel, it will reduce to approximately 1/4 its size, but it will
print to a Postscript device at 288 dots per inch.

NOTE: Usually, you should use 288 as opposed to 300 d.p.i. for the LaserWriter. This will
produce a cleaner printout and will print much more quickly. This is because 288 is an even
multiple of 72 and thus less math is needed and fewer round-off errors will be introduced. The
same is true of 144 versus 150 d.p.i..

13
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Change Bitmap Resolution

Resolution (dots per inch)
O72d.p.i. O144d.p.i. O 150 d.p.i

| @ 288 d.p.i. O 300 d.p.i.

() Other

(O Maintain image size
@ Same number of bits in image

(o) (conem)

In the illustration, we show the original art and the finished 288 d.p.i. image. It is important to
be sure to choose Same number of bits in image if you wish to go from the larger version

to the smaller.

The second (and more precise) method of creating a high-resolution easel is to start from a
smaller image which is exactly the size you need, and then to use the Bitmap Resolution

command to scale it for you.
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First, create an easel the size you need

and rough in a sketch of what you want to draw.

Like so. Next select Bitmap Resolution from the Windows menu (or

double-click on the Laserbits tool E ) and choose 288 d.p.i. and Maintain image size.

Change Bitmap Resolution

Resolution (dots per inch)
O72dpl. Ol4dd.pl O 150 d.p.l.
IE} 288 d.p.i. l[:} 300 d.p.l.

O Dther E|

® Maintain image size
) Seme number of bits In image

and click OK.

The picture in the easel will change slightly. Now click on the Laserbits tool to expand the
easel to allow you to clean up the image.
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You can now use any of the art tools to clean up the image. When it is deselected, it will return
to the smaller size. It will print out at 288 d.p.i. on any device capable of that resolution (or
higher).

P e
P g a
A

NOTE: An easel cannot be turned into a high-resolution easel until it contains artwork (even a
single pixel). You cannot draw on a high-resolution easel until it has been expanded (by
clicking on the laser bits tool).

Exactly the same methods can be used at any resolution you wish to enter. The preset values
are 72 (the resolution of the screen), 144, 288, 150, and 300. There is a special area where
you can enter any resolution you wish— the only limits are available RAM and your patience
(after all, working an image at 2500 d.p.i. is going to get a little tedious!).

TIFF Files

A new standard for the transfer of high-resolution images has recently been adopted by nearly
all the manufacturers of high-resolution scanners. Support for this file format, called TIFF
(Tagged Image File Format), allows an application to directly import scanned images at a
variety of resolutions. GraphicWorks 1.1 has a new command in the File menu called
Place TIFF.

When you select Place TIFF, you will be presented with the standard Macintosh file dialog
with all available TIFF files displayed.

S TIFFs

O cheese.tff 5
D drawing.part.tiff

b Ell‘lmld.'llﬂ

I

O Graphiclllorks {3} MacPaint O TIFF
] Open as Untitled
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Double-click on the name of the TIFF file you wish to place (or click on the name and then
click on Open) and the file will be read and processed. TIFF files can be quite large and the
decoding process can be rather time-consuming, so a dialog will appear to apprise you of the
work in progress as the image is translated

Reading TIFF file with 371 lines of data.

Currently processing line 16.

To Cancel press "%." (Command + period).

When the image has been processed, it will appear on the screen as a standard high-
resolution easel. From here, the TIFF image behaves exactly like any other GraphicWorks
1.1 high-resolution image. Use the Laserbits tool to expand the image to working size. All of
the drawing tools work as normal on the TIFF image. You can even change the bitmap
resolution from the default value read from the file.

TIFF files can also be loaded by using the Open command. This will create a new document
consisting of a single panel which contains the TIFF image.

To prepare a file from your scanner for import to GraphicWorks 1.1, simply follow the
instructions to scan and save as TIFF whatever portion of your document you want to import to
GraphicWorks. When the file is imported, it will retain all information present in the scanned
image, including size and resolution. It's that simple.

A few points about high-resolution easels that you should know. First, they are going to take a
while to print. A single 8 x 10 inch image at 288 d.p.i. is the equivalent when printing of 16
MacPaint documents. Print speed can be enhanced in a number of ways, however. Whenever
you are printing a high-resolution easel, be sure to turn off smoothing (from the Page Setup
dialog). This will significantly speed the printing, and as you can't really gain much from
smoothing a 300 d.p.i. image anyway, it should cause no hardship. Another method to speed
things up is to use the Or ink mode for the high-resolution easel. This is the fastest ink mode
when printing. Finally, whenever possible, use resolutions that are even multiples of 72 (i.e.
144 and 288) as the math involved in the image scaling is far simpler and faster than with odd
values such as 150 or 300.
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Color Printing

GraphicWorks 1.1 allows owners of ImageWriter |l printers to print in color without
additional software. Any object can be assigned both a foreground and a background color.
This includes bitmaps, text balloons, primitives, and panels.

To print in color, you must have an ImageWriter |l printer with a color ribbon attached to your
Macintosh and selected from the Chooser.

You can assign a color to an object at any time. To choose a color for an object, select the
object and then choose foreground and background colors for it from the Colors window.
Note: You cannot change the color of a PICT image.

E=—=—————— tolors =x—]

ForeGround Color (black bits) BackGround Color (white bits)

All of the black pixels in the image will be printed in the foreground color, and all of the white
pixels will be printed in the background color. Note that changing the background color from
white will seem to fill the area in question with black (at least until you get a color monitor!).
This is because the Macintosh ROM will display all colors except white as black pixels on the
screen. Don't worry though, the colors will print just fine. Note, however, that if you select
IGNORE COLOR VALUES (from the Preferences window), images will be displayed
normally on the screen (black and white — even on a color screen).

The ink modes all work for color as well as for black and white objects. The most important two
modes are OR and MATTE. OR is the default mode. When an image is OR'd, only the black (or
foreground color) dots are imaged. This means that setting the background color on an object
to be OR'd is ineffective. If you wish to set a background color for an object and have it print
properly, use MATTE which first erases the area under the object to white (background). Other
ink modes have other effects which may not be immediately obvious., so experimentation is
the key here.
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Other Changes

Special Effects
There are four new tools available for editing art in easels. They are known collectively as the

special effects tools. Each of the four tools is used in the same way: click on the tool, use it to
select an area within the easel, and ‘grab’ a corner and reshape the area. You can also copy
the selected area to the clipboard. Any changes made to a selected area can be undone.

Rotate

Skew

Perspective

Distort

GraphicWorks 1.1 allows you to draw shapes from the center. Normally when you draw a
rectangle, round rectangle, or oval in an easel, the shape is drawn from the upper left, from

19



the first point you click on. By holding down the Option key as you draw, however, the first
point you click on will be the center of the shape.

Panels

Panels now default to transparent backgrounds. This is different from version 1.0 in which
panels were always opaque. When you load an older document into version 1.1, it will be
converted so that panels will look the same as they did before.

You can set the fill and line patterns of a panel by selecting them from the palette window
while the panel is selected.

When a panel is copied to the Scrapbook; it will be placed there as a panel and as a picture (if
enough memory exists to create the picture). Thus you can now paste a panel into another
application which accepts PICT data and have it print at full printer resolution.

Text Areas
Text areas can now be transparent or reversed. Select NONE from the palette window for a

transparent balloon. This can also be set from the Ink window by choosing OR. If you need
white type on a black background, select black from the palette or NOTOR from the Ink
window. These modes are not available for the specialty "cloud” shapes.

Easels
The default ink mode for a new easel is OR. All other modes are still available, however.

Print Options
The Print Options dialog has changed slightly.

Printing Options

[ Card format printing —| vewc
(] Print just the selected panel

[ Print grid {C on top of images O text

Imagelliriter 1 Options :
| LlBitmap 'graging’ in ‘Best’ quality

: Laseriliriter Options :

] Print page as bit image
[] Disable automatic 96% scaling
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Most of the choices are self-explanatory. The last two, however mark changes from the
previous version of the program.

The default print mode is now to print the page as a fully-detailed collection of objects
(previously this was chosen by selecting Print page detailed). Choosing Print page as
bit image chooses to print the page as if it were coming from MacPaint or FullPaint. While
this mode can be faster and may be suitable for large paintings or rough layouts, it degrades
the quality of text, primitive and high-resolution objects to what they appear as on screen.

GraphicWorks 1.1 automatically scales all objects by 96% when printing to correct for an
aspect ratio discrepancy between the screen and the printer. While this allows better
WYSIWYG operation, sometimes you may wish to disable the scaling. In that case, select
Disable automatic 96% scaling.

The Edit Menu
Two new commands have been added to the Edit menu.

The first new command, Paste as Picture, allows you to paste an image into a selected
panel as a PICT. Use this command to paste art from MacDraw™ or Cricket Draw™ into your
documents. You can also copy a panel or easel to the clipboard and use this command to
paste them in as PICTs.

Duplicate can be used to make a copy of any object including panels. If you reposition the
first duplicate and then use the duplicate command a second time, the new object will be
placed in relation to the second item as that item is to the first.

Preferences
The preferences window combines several useful commands into one window.

Font size (6-127)

Line thickness (1-72)

) screen units (72 dpl)
@ Laseriiriter units (300 dpi)

[ Ignore color values.
] Twrn off page buffer imaging.

(& ] (o)

Set the scaling amount exactly as you would in version 1.0. Simply type a number from 1 to
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999. The percentage you type will become the percentage listed in the Edit menu. Scale by
XxX% can be used to scale selected areas in bitmaps or entire PICTs. In the first case, the
original bits are lost once the scaling has been done. In the second case, all of the information
contained in the PICT is retained.

Set the font size to add a size not listed in the standard Size menu. You can enter any integer
between 6 and 127 as a font size. The number you enter will appear at the bottom of the Size
menu.

Set the line thickness to control the size of lines and borders for panels, primitives,

balloons and bitmap tools. Type an integer between 1 and 36 to set the width of the Custom
line. Five is the default setting and represents the smallest line the screen can display (1/72
inch). The smaller numbers (1-4) represent hairlines. These thinner lines will only print on a
PostScript device.

Ignore Color Values sets the colors on the screen to black and white even if other color
values have been set. Images will print in color on the ImageWriter Il even if Ignore Color
Values has been selected.

Turn off page buffer imaging allows you to gain extra memory for your document at a
considerable cost in scrolling and imaging speed. This has the effect of eliminating the in-
memory copies of the page which are used for scrolling. Thus, the page must be re-built when
new areas are scrolled into view. This feature allows you to see colors on-screen on those
models that accommodate color.

Grid Maker and Rulers
Grid Maker

Grid maker is used exactly as it did before, but Pica has been added as a scale choice. Also,
you can now choose to align drawing tools to the grid independently of easels. Although
you've always been able to align to the grid lines or to the halfway point between grid lines, a
new option, "Snap to Grid," will cause objects and tools to align only to the grid lines
themselves.
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Align to Grid
[JPanel []Drawing Tools
] Easel [] Balloon

] snap to grid

Grid Alignment on Page

@ top left
O center

(O bottom right

=]

L el
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O Illsplu-g.l Grid Ruler Scale
@® Inches () Metric
[ ox | [cencel ]  Opoints O Pica |

Rulers
Choose Show Rulers to display rulers along the top and side of the screen. Two small

arrows continuously track the position of the cursor. You can align the zero points of the rulers
by clicking and dragging guides from the small corner box (labeled with the current unit of
measure). The Show Rulers command will change to Hide Rulers when it is chosen.
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Printing Strategies

The LaserWriter is a great device, but it often seems to suffer from a lack of speed, especially
when printing the complex documents created by GraphicWorks. GraphicWorks 1.1 does
several things to speed up printing to the LaserWriter and there are several other things you
can do to help when you create your documents.

One of the most important things to remember when creating a GraphicWorks 1.1
document is that the fastest ink modes when printing (and the least memory intensive) are
COPY and OR. If you have art which does not overlap any other art, then use the OR mode. If
your images overlap only on clean rectangular boundaries, consider using COPY. The default
mode for all objects is now OR.

When creating a page containing multiple layers of bitmaps, try to keep as many as possible
in immediate succession in the stack. If, for instance, there are ten separate bitmaps, one on
top of the other, with no other objects in between, they will be merged in memory before
printing. This speeds things up considerably. If a balloon is placed between the fifth and sixth
layers, the first five will be merged and the second five will be merged, which will also be
faster than printing all ten individually.

When you are working with high-resolution easels, be sure to turn off smoothing and use a
d.p.i. factor which is an even multiple of 72. Not only will the page print faster, it will probably
look better too. The LaserWriter gray-scale patterns print much faster on a LaserWriter than
other patterns.

Note: For maximum speed when printing, avoid using fills for panels and balloons.
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Compatibility With Other Programs

Input

Gr':phlt:Wnrks 1.1 is completely compatible with any kind of graphics which can travel
through the clipboard. Art from MacPaint or Fullpaint can be pasted as easels or pictures. Art
from MacDraw or Cricket Draw or Pro3D can be pasted in as pictures and thus retain all the
original qualities of the drawing. In fact, Cricket Draw objects retain all PostScript attributes
when printing.

In addition, Graphlc\\‘nfkl 1.1 can directly open MacPaint and Fullpaint documents,
ComicWorks and GraphicWorks 1.0 documents, and TIFF files created by most scanner
manufacturers.

Output
GraphicWorks 1.1 can write files in its own proprietary format, as MacPaint documents, or
as PICT files.

The PICT files created by GraphicWorks 1.1 can be read by any program which can read
PICT (MacDraw, PageMaker, Ready-Set+Go, etc) but in some cases, you won't see quite what
you expect. MacDraw is the biggest problem. MacDraw does not understand any ink mode
except OR. If you have a bitmap placed on the page using MATTE, MacDraw will process it as
two images: the mask (all black) and the bitmap (OR'd on top of the mask).
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NOTE: Bold indicates a change from version 1.0

Command
Selected Panel
Bold

Copy
Duplicate
Trace Edges
Format Text
Patterns

Flop Horizontal
italic

Flip Vertical
Crop Work
Show Rulers
Switch Selection
New

Open

Plain

Quit

Rotate

Save
Transparent Paper
Underline
Paste

Wrap Panel
Cut

Tools

Undo

Center

Shuffle Up One
Shuffle Down One
Bring To Front
Send To Rear
Small Bits

Medium Bits
Large Bits

Clip Exception
Save As...

Show Grid

Up

Down

Scal by XX%

Left

Right

Increase Font Size
Decrease Font Size

GraphicWorks 1.1 Key Commands

Menu

| Feature ]
[ Style ]

[ Edit ]

[ Edit ]

[ Edit]

[ Layout ]

[ Window |

[ Edit ]

[ Style ]
[ Edit ]

[ Feature ]
[ Layout ]
[ Feature ]
[ File ]

[ File]

[ Style ]

[ File ]

[ Edit ]

[ File ]

| Feature ]
[ Style ]

[ Edit ]

| Feature ]
[ Edit ]

[ Window ]
[ Edit ]

[ Layout ]
[ Layout ]
[ Layout ]
[ Layout ]
[ Layout ]
[ Feature ]
[ Feature ]
[ Feature ]
| Feature |
[ File ]
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